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Solution Explorer 

Solution Explorer provides you with a convenient window into J.D. Edwards software. The 
system is designed to be a flexible, customizable system that can adapt to your business 
needs and offer a permanent solution to the problem of adapting to changing conditions and 
requirements.  

Key attributes that distinguish Solution Explorer include:  

• Ease of navigation. Solution Explorer offers a convenient, web-browser-based, 
customizable gateway to all features and to any internal or external web site. Using 
task views, you can create and use shortcuts to further speed your navigation and 
shorten your work time. Find It! allows you to quickly search for the programs that 
you need to do your work.  

• Flexibility. Reusable units of work, called tasks, are at the core of the Solution 
Explorer. You use these tasks as the basis to model and to create business and 
technical processes that can be modified without costly changes to the system.  

• Configurability. You can set up the system so that it displays only the tasks and 
processes that you need for your daily work. You can enable and disable tasks and 
create variations on processes to reflect the needs of the system's users.  

• Ease of use. Solution Explorer allows you to create special tasks, called activators, to 
build key business and technical processes without hard-coding form 
interconnections. Activators launch the Universal Director, which provides a graphical 
interface for the entire process you create and facilitates passing data between 
forms. The Universal Director also presents the steps included in a process in an 
easy-to-read format.  

• Compatibility. The Solution Explorer architecture permits software developers and 
integration partners to produce custom activators that are compatible with both third-
party software applications and with J.D. Edwards software.  

• Accountability. Documentation exists for most tasks in Solution Explorer, which 
eliminates guesswork when you encounter a task. You can also create your own 
documentation for new tasks. Documentation means that information about tasks is 
readily accessible, even as people come and go within your organization.  

How to Use This Guide  
An important fact about Solution Explorer is that different users with different needs can use it 
in many different ways. An end user who is performing business tasks such as journal entry 
will be most concerned with finding easy access to the tasks necessary to complete the job. 
Such a user will access Solution Explorer through the Home Page. This user will not be 
concerned with customizing the Solution Explorer.  

Users who want to quickly acquaint themselves with Solution Explorer's interface and 
understand in general terms the meaning of the content in the various components of the 
interface can review the Solution Explorer section in the Foundations guide.  

System administrators will be most concerned with setting up and maintaining system 
security. These users will need to skim the various sections to acquaint themselves with the 
basic structure of Solution Explorer, and then review the Security section in the System 
Administration guide  
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Solution Explorer Terminology at a Glance  
This guide explains in detail the concepts behind Solution Explorer. The following table briefly 
defines the most essential Solution Explorer terms.  

Solution 
Explorer 
Term  

Definition  

Home Page  A URL whose contents first appear when the user launches the Solution Explorer. You can 
set the URL by configuring the jde.ini file as shown below. In this example, the home page is 
configured to display the J.D. Edwards Portal.  

[EXPLORER]  

JASWebServer = "toolsjass1"  

JASPortalURL="http://toolsjass1/jdeowportal"  

JASForceEnv=  

ExplorerHomeURL="toolsjass1/jde/portal"  

ExplorerStart=home  

You can also configure the home page to display the last task the user viewed by setting 
ExplorerStart=task. To define a specific task view, set ExplorerStart=task:1234, 
where 1234 is the task view identifier.  

Solution 
Explorer  

A configurable Explorer for J.D. Edwards software and related objects that includes task 
content, when available.  

Tasks  Units of work that you use to build essential business processes. Tasks can be interactive 
applications, batch applications, constants, next numbers, Windows executables, and so on.  

Task 
relationships  

Series of tasks arranged in parent-child relationships that form business processes such as 
Procure to Pay.  

Task views  Collections of related task relationships, which appear in Solution Explorer.  

Task links  Shortcuts from one relationship to another. The linked task appears in a secondary window in 
Solution Explorer.  

Activators  Special tasks that you use to launch the Universal Director. Activators link logically together 
series of tasks; they allow business and technical professionals to make "on-the-fly" system 
changes and avoid costly down time.  

Universal 
Director  

A graphic user interface that the system launches when you access a task activator. The 
Universal Director provides a coherent framework for work with activators as well as the 
mechanism for passing data between the J.D. Edwards software forms required for 
completing the activator.  

Rough Cut  The process you use to create a high level task view configuration. Using Rough Cut, you 
establish criteria the system uses to enable or disable tasks and task relationships. Rough 
Cut question tasks are categories of tasks; Rough Cut answers are the allowable values for 
each category.  

Qualifier rules  Qualifier rules are if-then statements that you create, apply and use in conjunction with 
Rough Cut as the basis for enabling or disabling tasks. The system compares answers to 
Rough Cut questions to the criteria of the qualifier rules for each task and generates a batch 
process to enable or disable tasks based on the comparison.  
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Fine Cut  The process you use to selectively enable or disable tasks in a task view after you have 
created a task view configuration using Rough Cut.  

Task 
relationship 
variants  

A variation on a task relationship that you create using Fine Cut. In creating the variant you 
selectively disable tasks in the relationship, then save the variant. The system stores the 
variant, which you can activate as an alternative to the default task relationship.  

Setting Up the Home Page for the Solution Explorer 

The Home Page is generally the first screen a users sees when logging into the Solution 
Explorer. This screen can be used to display information relevant to end users in the 
enterprise. It can be an external web site, an intranet site, or even HTML files stored on any 
server or network. 

During the installation process, a directory called PortalLite is created when the deployment 
server is installed. This directory resides in the <baseinstall>\ActivEra™\ProtaLite directory 
and includes a set of html files that make up the default Home Page. Even thought this 
directory is on the deployment server, it can reside anywhere on the network – such as on a 
web server or even locally on a workstation. 

When the OneWorld® client is installed, the system updates the client jde.ini to point to the 
location of the PortaLite directory. For example, if the name of the deployment server is 
“DepServer1” and the share name is “B7333”, the [Explorer] section of the jde.ini is updated 
as follows: 

[Explorer] 

ExplorerHomeURL=”\\DepServer1\b7333\activEra\portallite\index.html 

ExplorerStart=INTERNET 

You can change the above parameters in the jde.ini file to display any html file or URL as the 
default Home Page. The table below describes these parameters: 

[Explorer] Parameter Description 
ExplorerHomeURL= URL or filename of the Home Page that is displayed when the user 

logs on. By default, the initial page is 
\\Depserver1\b7333\activera\portalite\index.html. 

ExplorerStart= Valid values are: 

INTERNET: This is the default value. When you start the Solution 
Explorer, it displays the internet view first. 

TASK: When you start the Solution Explorer, it displays the last task 
view the user viewed. To display a specific task view, set 
ExplorerStart=TASK:xx, where xx is the task view’s task ID. 

 

 

3 



Task Views 

Initial Configuration  

After installing J.D. Edwards software, launch the Solution Explorer, and then access the 
Getting Started task view. This task view orients you to the Solution Explorer. Your next step 
is to access the Implementation Approach task view. This task view provides a detailed 
implementation strategy that guides you through the J.D. Edwards software configuration and 
implementation process. The Implementation Approach task view represents information 
gathered from numerous implementation experts. When using these task views, make sure 
the Documentation window is visible. Documentation on how to use these task views appear 
in the Documentation window when you launch each task view.  

Note 
The Application Set Up Tasks Tasks task view is closely related to the Implementation 
Approach task view. You will probably never work with the Application Set Up Tasks Tasks 
task view on its own; it contains numerous link target tasks from the Implementation 
Approach task view that can simplify the implementation software tasks you need to perform.  

 
While implementing J.D. Edwards software, one of the first steps in setting up the Solution 
Explorer is defining your business within the system to help determine which OneWorld tasks 
will be available to your users. To do this, you use a utility called Rough Cut. Rough Cut 
contains a list of descriptors that can be applied to business systems. Choosing some values 
and not others helps you to configure Solution Explorer so that it will display only those tasks 
that users need to do their work. 

For example, your system might be built purely around automotives. Consequently, you 
would select only Automotive from the Rough Cut category Industry. By doing so, you provide 
the system with information so that it can disable certain tasks that your automotive business 
would not use, such as pharmaceutical tracking processes.  

The results generated by Rough Cut (enabling and disabling tasks) are reflected in all of the 
Solution Explorer task views. After using Rough Cut, you use another utility, Fine Cut, to 
refine the configuration. As your business changes over time, you will continue to use Fine 
Cut to enable and disable applicable tasks.  

Rough Cut consists of lists of categories (also known as questions), arranged in a 
hierarchical menu structure. Each category contains multiple values.  

Performing the Initial Configuration  

You perform the initial configuration for your system using Rough Cut. Rough Cut displays 
information categories that broadly define a business system. You select which categories 
are applicable to your business system. Based on how you define your system in Rough Cut, 
the system enables certain tasks and disables others. Then you use Fine Cut to override the 
system's suggestions where necessary.  

Defining your business system in OneWorld need not occur within a single session. You can 
save your work at any time and return to Rough Cut later to continue, if necessary. The 
system stores your selections in the Environment Setup Answers table (F9010).  
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See Also  
� Refining the Configuration for information on using Fine Cut to refine Rough Cut 

results  

► To perform the initial configuration  

1. In the Solution Explorer, choose Rough Cut from the Tools menu.  

The Rough Cut task view appears.  

2. Expand a Rough Cut category, such as Select Required Software Products, and 
choose the categories that apply to your business system.  

The default is that all of the categories are selected. 

Many categories have subcategories. Parent categories can be symbolized with a 
book icon or with a checkbox. Choosing a parent-level checkbox selects all of its 
children.  

3. Continue through all of the categories, checking those items that are applicable to 
your system and leaving blank those that are not.  

4. Click the Save Data button on the Toolbar.  

You can save your work at any time. However, you must save before performing the 
next step.  

5. Click the Idea to Action button on the Toolbar.  

6. On Apply Rough Cut Answers, click Yes. 

The system analyzes all of the tasks in the system and enables or disables them 
based on your input. This process might take a few minutes.  

Configuration Refinement  

One of the initial configuration tasks for the Solution Explorer is to use Rough Cut to define 
your business system. Based on your choices, Rough Cut processes all of the OneWorld 
tasks and disables several tasks. To refine the initial configuration you use the utility called 
Fine Cut. After refinement, all of the tasks are appropriately enabled or disabled.  

After your initial configuration, as your business changes over time, you can continue to use 
Fine Cut to enable and disable tasks as appropriate.  

In Fine Cut, you selectively enable and disable tasks by choosing them and clicking buttons 
on the Toolbar. Then, when you execute Fine Cut, the system changes the properties of the 
affected tasks, which are stored in the Task Master table (F9000).  

You can choose to hide or show tasks that you have disabled using Fine Cut by turning on or 
off the Show/Hide Disabled Tasks button on the Toolbar. The system enables this button 
after you turn Fine Cut off. Turning off the Show/Hide Disabled Tasks button hides disabled 
tasks from the task view and simplifies navigation.  

However, you might choose to show disabled tasks if you want to keep track of all the tasks 
in a particular task view and their relationships, particularly if you plan on using Fine Cut 
frequently. If you click the Show/Hide Disabled Tasks button, the system displays the 
disabled tasks with a red X.  
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Hiding and showing disabled tasks affects how you see your task views only. If you choose to 
show disabled tasks, other users will not see the disabled tasks in their task views.  

Refining the Configuration  

You use Fine Cut to selectively enable or disable specific tasks in your implementation of the 
J.D. Edwards system.  

► To refine the configuration  

1. In the task view of Solution Explorer that you want to refine, click the Fine Cut button 
on the Toolbar.  

The system changes the task view menu to indicate enabled and disabled tasks. 
Enabled tasks are indicated by a green checkmark; disabled tasks are indicated by a 
red X.  

 

 

2. Expand the task tree in the task view to find a task that you want to enable or disable.  

3. Select a task.  

4. Click either the Enable or Disable button on the Toolbar.  

You can also double-click the task to toggle between the enabled and disabled 
conditions.  

5. Repeat steps 2-4 for each task you want to enable or disable.  

6. When you have finished refining the task list, click the Save Data button.  
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If you fail to save the changes, the system cannot store the new parameters, and 
your changes will not remain if you exit the Solution Explorer and then launch it again 
later.  

7. Click the Fine Cut button to exit Fine Cut mode.  

8. Click the Show/Hide Disabled Tasks button to toggle between hiding and displaying 
disabled tasks in the current task view menu.  

Task View Set Up  

Tasks are the most discrete units in the Solution Explorer. Tasks are organized into 
hierarchical tree structures inside of task views. J.D. Edwards provides thousands of tasks 
and you can add more of your own. When placed in a single task view, finding a specific task 
among thousands might be difficult and time-consuming.  

Instead of having only one task view in which all of the tasks in the system appear, the 
Solution Explorer allows you to have many different task views, each displaying only some of 
the tasks in the system.  

Typically, tasks are grouped in a task view because they relate to a common business 
system, process, or function. Logical selection and grouping of tasks in this way can make it 
easier for users to find the functions they need. You can further refine which tasks a user 
sees in a task view by designating a task view to be role based. Role based task views allow 
users to apply a role filter to the view that will display only those tasks associated with the 
role that the user applied. Users can only apply roles for which they have been granted 
access.  

Additionally, you can prevent users who only have View access to the Solution Explorer from 
seeing task views you set as being secured.  

See Also  
� Working with Task View Variants for information about creating and modifying task 

menu variants  

� Task Set Up for information about creating, working with, and documenting tasks  

� Working with Task Links for information about creating links between tasks to aid 
navigation through task views  

Working with Task Views  

Task views are groups of tasks arranged in a hierarchical tree structure.  

Creating a New Task View  

Create a new task view if you want a new category of tasks to which you want to insert tasks 
and build task relationships.  

See Also  
� Working with Tasks  

� Creating a Task 
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► To create a new task view  

1. On Solution Explorer, choose Add a New Task View from the Tools menu.  

2. On Task View Revisions, complete the following fields, and then click OK:  

• Task View 

Enter an internal ID for the Task View. The ID must be between two and five 
numbers long and cannot contain alpha characters. If you start the ID with more 
than one zero, the system will truncate it to a single zero. For example, if you 
input 005 as an ID, the system will change the number to 05.  

• Name 

• Description 

The name and the description do not have to be the same.  

• Secured Task View 

• Role Based Task View 

If you want users to be able to filter tasks in the task view based on their roles, 
select this option.  

Changing a Task View  

You can modify an existing task view. For example, you might want to change the name of a 
task view so that it more accurately reflects the category of tasks in that view.  

See Also  
� Working with Task Views for information about copying or moving task view menu 

nodes  

� Working with Task View Variants for information about providing alternate views of 
task view menus and nodes  

� Working with Tasks for information about copying, moving, and deleting tasks  

► To change a task view  

1. On Solution Explorer, choose Work With Tasks from the Tools menu.  

Alternately, if you want to change the current task view, right-click the top task view 
node and choose Task Revisions from the menu. Skip to step 5. 

2. On Work with Tasks, choose Task Views from the Form menu.  

3. On Work with Task Views, click Find.  

Use the QBE row to refine your search.  

4. Choose the task view you want to change, and then click Select.  

5. On Task View Revisions, change any of the following fields, and then click OK:  

• Name 
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• Description 

The name and the description do not have to be the same.  

• Secured Task View 

• Role Based Task View 

If you want users to be able to filter tasks in the task view based on their roles, 
select this option.  

Deleting a Task View  

You can delete any task view from the system. Deleting a task view does not delete the tasks 
within the view from the system, however.  

See Also  

• Creating a New Task View for information on securing task views from users who 
only have View access to the Solution Explorer  

• Deleting a Task for information on removing tasks from the system  

► To delete a task view  

1. On Solution Explorer, choose Work With Tasks from the Tools menu.  

2. On Work with Tasks, choose Task Views from the Form menu.  

3. On Work with Task Views, click Find.  

Use the QBE row to refine your search.  

4. Choose a task view, and then click Delete.  

5. On Confirm Delete, click OK. 

Working with Task View Variants  

You might want to customize certain task views or parts of task views for specific user 
groups. The system allows you to do so with variants. A variant is a subset of the tasks in the 
original task view. Variants allow you to customize and simplify task views. You can create a 
variant of the entire task view by making a variant of the task view node (the first node at the 
top of the task view menu), or you can create a variant of any of the parent tasks in the task 
view.  

You can use variants to make different versions of task objects available to users, and you 
can vary the descriptions of the tasks as well. Furthermore, when linking to a node that has 
one or more available variants, you can choose to link to the base view or to any of the 
variants instead. The variant does not replace the original task view menu; it is an alternate 
view which the user must apply and clear manually or that you can cause to be displayed as 
the target of a link. Note that if you create a variant of a specific node in the task view, the 
user must know which node to select to be able to apply the variant.  
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See Also  

• Working with Task Links for information about linking tasks to help users move 
quickly from one task to another without searching for it  

• Working with Variant Task Views in the Foundation guide for information about 
applying and clearing task view menu variants  

Creating a Variant  

To create a variant, you refine the task view using Fine Cut, then save the variant. You create 
the variant based on your needs analysis of the variant users.  

► To create a variant  

1. In a task view of Solution Explorer, click the Fine Cut button on the Toolbar.  

2. Select a parent task and expand the task tree to expose tasks that you want to 
disable.  

3. Select each task that you want to disable, and then click the Disable button.  

4. After you have disabled all the tasks that you do not want to appear in the variant, 
select the parent task.  

5. Right-click and choose Save Variant from the menu.  

6. On Create New Variant, enter a name for the variant, and then click OK.  

The system saves your variant to the Variant Description (F9005) and the Variant 
Detail (F9006) tables. This operation might take a few minutes.  

Changing a Variant  

The ability to modify variants allows you an extra measure of control over the configuration of 
your Solution Explorer task view. Overriding the default task name and task version, for 
example, further differentiates a variant from the default version. Changing the name and 
version for the variant makes it easier for you and other users to understand the difference 
between the variant and the default view. You might want to work with a different application 
version than the default when you are in a variant view, and you can set that version with an 
override. After you have set the override, you do not have to change the version for the task 
in the variant again, unless you decide that you want to.  

Keep in mind that the changes you make to the variant, such as assigning new task names, 
apply only to the variant. The system preserves the properties that define the default view. 
You are not replacing the original view; you are creating an alternative to be used in specific 
situations required by your business.  

► To change a variant  

1. In a task view of Solution Explorer, click the Fine Cut button on the Toolbar.  

2. Select the parent task of the task relationship that has a variant.  

3. Right-click the parent task, and then choose Manage Variants from the menu.  

4. On Variant Name Search & Select, choose the variant you want to change, and then 
click Select.  

The Variant Definition form appears, displaying all of the child tasks under the current 
node.  
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Alternately, you can access the Variant Definition form from the Content 
Development Tools task view. Launch the Work With Variants task, and then find and 
select the variant you want to change.  

5. Change the columns in the rows as desired, and then click OK:  

• Active 

• Override Task Name 

• Override Task Version 

6. Close the Variant Name Search & Select form.  

7. Click the Fine Cut button to exit Fine Cut Mode.  

Deleting a Variant  

You must use the Work with Variants application to delete a variant.  

► To delete a variant  

1. From the Content Development Tools task view, launch the Work With Variants task.  

2. On Work with Variants, click Find.  

Use the QBE row to refine your search.  

3. Choose the variant you want to delete, and then click Delete.  

4. On Confirm Delete, click OK. 

Task Set Up  

To design and manage your system, you work with tasks—units of work that you use to build 
essential business processes. Tasks can be interactive applications, batch applications, 
constants, next numbers, Windows executables, and so on. You work with tasks in a Solution 
Explorer task view, which is a collection of related tasks hierarchically grouped in parent-child 
relationships, illustrated graphically by the task view menu. These task groups usually 
represent the steps in an essential business processes such as Procure to Pay.  

J.D. Edwards provides a large selection of tasks which are already grouped in relationships 
within different task views. You can build on this base by modifying already existing tasks and 
their relationships. You can also create new tasks, task relationships, and views.  

Within a task view, you insert new or existing tasks and arrange the tasks in logical 
sequences. You create or revise tasks on an ongoing basis, and then insert them to a task 
view as you deem necessary to build and enhance your business processes. The processes 
are fluid: you can drag and drop tasks and task relationships to change the relationships and 
the order in which you perform tasks.  

The system stores each task in a task view in the Task Master table (F9000) and assigns a 
unique ID to each one. Each task is a reusable object that you can insert into an existing task 
relationship, or you can use as a basis for creating a new task relationship. After you have 
inserted a task in a task view, you can move it, revise it, write documentation for it, set up 
processing options, set up versions, and locate it. You can accomplish any of these functions 
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in a Solution Explorer task view, by launching interactive applications or using features and 
functions encompassed within Solution Explorer.  

See Also  

• Task View Set Up for information about creating and maintaining task views  

• Working with Task View Variants for information about creating and modifying task 
view variants  

• Working with Task Links for information about creating links between tasks to aid 
navigation through task views  

Understanding Task Types  

When you create a task, you will be able to classify it in one of several ways. Each type of 
task is represented in the task view menu with its own icon. The Solution Explorer task types 
are:  

• Interactive  

• Batch  

• Windows  

• Non-software  

• Activity script  

• User defined code  

• Processing option  

• AAI  

• Constant  

• Next number  

Interactive  

Use this category for interactive J.D. Edwards software applications (with the exceptions of 
AAI and Constant applications). When the user runs this task, the application launches. You 
can define which version and even which form you want the task to launch, if desired. You 
can also control whether the user is prompted for processing options and in what mode 
(default, add, update, delete) the form will open. This last parameter is typically used only 
when the task will be used in a Universal Director process.  

Batch  

Use this category for batch J.D. Edwards software applications (such as reports). When the 
user runs this task, the batch application is submitted for processing. You can define which 
version you want the task to launch. You can also control how the user is prompted to set 
processing options and data selection.  
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Windows  

Use this category for Windows executable files. When the user executes this task, the system 
calls the Windows program. To use this option, you define the executable, its working 
directory, and the command-line parameters you want to pass to the program.  

Non-Software  

Use this category to create graphic placeholders in a task view. For example, you might want 
to group a number of procure to pay batch applications within the tree structure. You could 
create a non-software task called Procure to Pay Batch to act as the parent task and then 
place all of the batch-related tasks under it.  

Activity Script  

Use this category to define HTML-editable documents that are attached to Solution Modeler 
tasks.  

User Defined Code  

Define a task as a User Defined Code to access the Work with User Defined Codes form. 
The parameters you define for this task type (product code and UDC) are passed to the form 
so the user can work with the UDC set you specify.  

Processing Option  

Define a task as a processing option to bring up the processing options for the application 
you specify. You can also define the application version and the mode that the form appears 
in.  

AAI  

Use this category for interactive J.D. Edwards software applications affecting automatic 
accounting instructions. This type of task is identical to the Interactive task type except that its 
icon in the task view menu is different from the Interactive task type icon.  

Constant  

Use this category for interactive J.D. Edwards software applications affecting the constant 
values for a system. This type of task is identical to the Interactive task type except that its 
icon in the task view menu is different from the Interactive task type icon.  

Next Number  

Use this category to create a task that brings up the Set Up Next Numbers by System form 
when you execute it. This task type requires the product code of the system you want to 
affect.  
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Creating a Task  

The tasks in task views are reusable objects, which add to the flexibility of the Solution 
Explorer. Tasks reside in the Task Master table (F9000).  

You can create a new task directly in the Solution Explorer by inserting a new task in a task 
view menu. You define the task with the Task Revisions form. When you create a task, you 
automatically create a relationship between the new child task and the parent task under 
which you inserted the new task.  

Before You Begin  
� If you are creating a task to launch an object such as an application, the object must 

already exist in the system before you can create a task for it. For example, you 
might want to design a new report and then make it available for processing via a 
task in a task view. Before you create a task that launches a report, you must first 
design and check in the report.  

► To create a task  

1. In a task view, select the task that will be the parent of the task that you want to 
create.  

2. Right-click the task and choose Insert New Task from the menu.  

3. On Task Revisions, complete the following field.  

• Task Name 

4. Click the Common tab, and then complete the following fields:  

• Product Code 

• Activator Type 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Activators for more information.  

• Client Platform 

Leave this field blank if the task you are creating runs on both Windows and Web 
clients. Otherwise, enter W to specify web client only, or C to specify Windows 
client only.  

• Country Code 

Leave this field blank if you want this task available for all users regardless of 
their country code. Otherwise, enter the country code users need assigned to 
access this task.  

• Required 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Activators for more information.  

• Active 
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Deactivating a task makes it unavailable to users in any task view. Generally, you 
will want to keep your new tasks active.  

5. Click the Executable tab, and then choose a task type option.  

Note 
Many of the task type options require that you enter additional information. For 
example, if you choose Interactive as a task type, you must supply the object name 
for the application, the version, and form names, and set up processing options, if 
any.  

 

• Interactive 

Select this option for a task that will launch an interactive J.D. Edwards software 
application.  

• Application 

Enter the application's object name. Click the Visual Assist to search for an 
application.  

• Version 

This is an optional field. To launch a specific version of an application, enter the 
version. Click the Visual Assist to search for a version.  

• Form 

This is an optional field. To open a specific form in the application, enter the form 
ID. Click the Visual Assist to search for a form.  

• Option Code 

• Form Mode 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Activators for more information.  

• Batch 

Select this option for a task that will launch a J.D. Edwards software batch 
application.  

• Application 

Enter the batch application's object name. Click the Visual Assist to search for an 
application.  

• Version 

This is an optional field. To launch a specific version of a batch application, enter 
the version. Click the Visual Assist to search for a version.  

• No Processing Options 
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Select this option to execute the batch application without processing options.  

• Blind Execution 

Select this option to execute the batch application without displaying its 
processing options.  

• Prompt for Version 

Select this option if you want to prompt the user to select which version of the 
batch application to run at execution.  

• Prompt for Values 

Select this option if you want to prompt the user to enter processing option 
values at execution.  

• Data Selection 

Select this option if you want to prompt the user to enter data selection at 
execution.  

• Data Selection and Values 

Select this option if you want to prompt the user to enter data selection and 
processing option values at execution.  

• Windows 

Select this option for a task that will launch a Windows-based executable.  

• Windows Executable 

Enter the executable name.  

• Working Directory 

This is an optional field. Enter the directory where the executable resides.  

• Executable Parameters 

This is an optional field. Enter any input commands, functions, or parameters you 
want to pass to the executable when it launches. Not all Windows executables 
accept parameters at launch.  

• Non-Software 

Select this option for a task to be used as a placeholder in a task view. This task 
will not execute a function, but will be used to organize tasks in the tree.  

• Activity Script 
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Select this option for a task to be used as HTML text to be attached to a modeler 
task.  

• User Defined Code 

Select this option for a task that will launch the UDC application to allow a user to 
modify UDCs.  

• Product Code 

• User Defined Codes 

• Processing Option 

Select this option for a task that will display processing options for an application.  

• Application 

Enter the application's object name. Click the Visual Assist to search for an 
application.  

• Version 

This is an optional field. To launch a specific version of an application, enter the 
version. Click the Visual Assist to search for a version.  

• Option ID 

• AAI 

Select this option for a task that will launch an automatic accounting instruction 
application.  

• Application 

Enter the application's object name. Click the Visual Assist to search for an 
application.  

• Version 

This is an optional field. To launch a specific version of an application, enter the 
version. Click the Visual Assist to search for a version.  

• Form 

This is an optional field. To open a specific form in the application, enter the form 
ID. Click the Visual Assist to search for a form.  

• Option Code 

• Form Mode 
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Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Activators for more information.  

• Constant 

Select this option for a task that will launch an application to allow the user to 
modify constants.  

• Application 

Enter the application's object name. Click the Visual Assist to search for an 
application.  

• Version 

This is an optional field. To launch a specific version of an application, enter the 
version. Click the Visual Assist to search for a version.  

• Form 

This is an optional field. To open a specific form in the application, enter the form 
ID. Click the Visual Assist to search for a form.  

• Option Code 

• Form Mode 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Activators for more information.  

• Next Number 

Use Next Number to launch the Set Up Next Numbers by System form.  

• Product Code 

6. Click the Resources tab, and then complete the following fields:  

• Base Resource 

• Base Units 

• Unit of Measure 

7. To apply roles to the task, choose Roles from the Form menu.  

8. On Role Definition, choose the role that you want to apply to the task, and then 
choose Change Status from the Row menu.  

A checkmark appears to indicate the role is applied to the task. To remove a 
checkmark, choose Change Status from the Row menu again. To apply all roles to 
the task, choose Enable All from the Form menu.  
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9. Click Close.  

10. On Task Revisions, click OK.  

Working with Tasks  

The tasks in task views are reusable objects, which adds to the flexibility of the Solution 
Explorer. Not only can you create tasks and insert them into the appropriate task view; you 
can build tasks into task relationships that represent key business processes. You can also 
move tasks freely within a task view by dragging and dropping them into the appropriate task 
relationship. You can revise task properties, set processing options and interactive versions, 
and reuse the same task in as many different task relationships as necessary.  

Tasks reside in the Task Master table (F9000).  

Inserting an Existing Task  

When you insert a task and thereby create a task relationship, the system stores the parent-
child relationship that you create in the Task Relationships table (F9001). The system also 
stores the task view into which you inserted the task.  

Because tasks are reusable objects, you can insert the same task into multiple task views.  

► To insert an existing task  

1. In a task view of Solution Explorer, select a task that will be the parent of the task that 
you want to insert.  

2. Right-click the parent task, and then choose Insert Existing Task from the menu.  
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The Task Relationship Revisions form appears. The form displays the parent task ID 
and all tasks that are children of the parent task you selected.  

 

 

3. Click a new line, and complete the following required fields:  

• Child Task ID 

Use the Search button to access the Task Search & Select form where you can 
find the task you want to insert.  

• Presentation Sequence 

If you want the task that you are inserting to appear in a position other than last 
in the presentation sequence, be sure to change the presentation sequence of 
the other tasks. For example, if the task you are inserting is in the eighth position, 
but you want it to appear second, you will have to change the presentation 
sequence of the task that is currently second to third, the third to fourth, and so 
on.  

4. Complete any of the following fields:  

• Active 

• Required 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Working with Task Links for more information.  

• Task View 

• Activator Type 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Linking Tasks To Create a Process for more information.  
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• Override Resource 

• Override Units 

• Unit of Measure 

• Auto Data Passing 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Linking Tasks To Create a Process for more information.  

• Override Form Mode 

Leave this field blank unless you plan on using this task as part of a Universal 
Director process. See Linking Tasks To Create a Process for more information.  

5. Click OK.  

Setting Default Processing Options for a Task  

You can set processing options, if they exist, for an interactive, AAI, constant, or batch 
application task. Even though you input the values, the user will still have an opportunity to 
change the values when he or she launches the task.  

► To set processing options for a task  

1. In a task view of Solution Explorer, select an interactive, AAI, constant, or batch 
application task.  

2. Right-click the task, choose Prompt for, and then choose Values from the menu.  

The system launches the processing options form for the task. Note that if processing 
options for the application do not exist, the Prompt for Values option is disabled.  

3. Enter processing options for the task, and then click OK.  

Setting Versions for a Task  

You can choose which version of an object a task will launch.  

► To set versions for a task  

1. In a task view of Solution Explorer, select an interactive, AAI, constant, or batch 
application task.  

2. Right-click the task, choose Prompt for, and then choose Versions. 

The OneWorld Work With Versions form or Work With Batch Versions form appears.  

3. Set up the interactive or batch version, and then click OK.  
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Applying Roles to a Task  

You apply roles to tasks so that the tasks will be filtered properly in role-based task views. 
You can apply one or more roles to each task.  

When a user launches a role-based task view, the system applies his or her default role to 
the view. If the system administrator has applied other roles to that user, he or she can apply 
them to the task view to see a different set of tasks.  

For example, a user might have two roles: General Accounting Clerk (the user's default role) 
and Accounts Payable Clerk. When the user launches a role-based task view, the system 
displays only those tasks to which the General Account Clerk role has been applied, such as 
Auto-reconcile Void Payments, Auto-reconcile Void Receipts, and Refresh Reconciliations 
File. The user can apply the Accounts Payable Clerk role to the task view, and the system 
displays only those tasks to which the Accounts Payable Clerk role has been applied, such 
as Speed Status Change, Create Payment Groups, and Work with Payments.  

See Also  
� Creating a Task for information about applying roles to a new task when you create it  

� Setting Up User Roles in the System Administration guide for information on applying 
roles to users  

► To apply roles to a task  

1. In a role-based Solution Explorer task view, select the task that you want to apply 
roles to.  

2. Right-click the task, and then choose Task Revisions.  

3. On Task Revisions, choose Roles from the Form menu.  

4. On Task Where Used, click Find.  

5. Choose the parent of the task to which you want to apply roles, and then click Select.  

6. On Role Definition, choose the a role that you want to apply to the task, and then 
choose Change Status from the Row menu.  

A checkmark appears to indicate that a role is applied to the task. To remove a 
checkmark, choose Change Status from the Row menu again. To apply all roles to 
the task, choose Enable All from the Form menu.  
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7. Click Close.  

8. On Task Revisions, click OK.  

Changing a Task  

 When you change a task using this process, you affect all instances of the task in the 
Solution Explorer. See Setting Processing Options for a Task and Setting Versions for a Task 
for information about affecting specific instances of tasks.  

► To change a task  

1. In a Solution Explorer task view, select the task that you want to change.  

2. Right-click the task, and then choose Task Revisions from the pop-up menu.  

3. On Task Revisions, complete any changes that you want to make to the task, and 
then click OK.  

See Creating a Task for more information about the available grid options.  

Deleting a Task  

You can delete an instance of a task from a task view menu. However, performing this action 
does not delete the task itself; it merely eliminates the task from the relationship. To delete a 
task from the system, you must go into the Work With Tasks form, locate the Task, and then 
delete it from the Task Master table.  
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Deleting an Instance of a Task  

You can delete a task from a relationship in a task view of Solution Explorer. Doing so 
deletes the task only from the task view; it still exists in the Task Master table and in any 
other relationship where it has been inserted. Furthermore, it can still be inserted into other 
task menus.  

► To delete an instance of a task  

1. In Solution Explorer, open the task view that contains the task relationship you want 
to delete.  

2. Right-click the task you want to delete, and then choose Delete Relationship from the 
menu.  

3. On Delete Relationship, click OK. 

Deleting a Task from the Task Master Table  

If you want to delete a task from the system completely, you must delete it from the Task 
Master table. Before you can do so, however, you must first delete all of the task's 
relationships. This is equivalent to deleting the task in each task view menu where it appears. 
The process below describes deleting the relationships as well as deleting the task itself.  

► To delete a task from the Task Master table  

1. In Solution Explorer, choose Work With Tasks from the Tools menu.  

2. Click Find.  

Use the QBE row to refine your search.  

3. Select the task you want to delete, and then choose Where Used from the Row 
menu.  

4. On Task where Used, search for the parent of the current task by clicking Find.  

The task might have more than one parent. If so, all of the parents appear.  

5. Choose the parent of the task you want to delete, and then click Select.  

6. On Task Relationship Revisions, select the task you want to delete, and then click 
Delete.  

7. On Confirm Delete, click OK. 

8. Click OK.  

9. Repeat steps 5-8 for each parent of the task in the list.  

10. When finished, on Task where Used, click Close.  

11. On Work With Tasks, select the task you want to delete, and then click Delete.  

12. On Confirm Delete, click OK. 

Working with Task Links  

A task link is a shortcut to another task. The linked task appears in an alternate window in the 
Solution Explorer, so you can still see your point of origin. Typically, links are made to tasks 
with children--nodes. When you link to a node, all of its children are visible in the new 
window.  
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You can link to any task in any task view except for the task view node itself. Optionally, you 
can link to a task view variant.  

When you create links, you must identify the link's two members: the task that you are linking 
from and the task that you are linking to. The task you are linking from is called the link task. 
The link task displays the link indicator. The task you jump to, called the link target, appears 
in the second window.  

You cannot link to a task view node.  

Creating a Link to a Task  

To create a task link, you revise the task relationships.  

► To create a link to a task  

1. In a task view of Solution Explorer, select the parent of the task that you want to 
make the link task.  

2. Right-click the task you selected, and then choose Task Relationships.  

The Task Relationship Revisions form appears, listing the child tasks of the parent 
you selected.  

3. From the list of tasks, click the task you want to set as the link task.  

4. From the Row menu, choose Link To.  

5. On the Link To form, click the Find Relationship button.  
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6. On the Find Relationship form, complete the following fields, and then click Find:  

• Task View 

Use the Visual Assist to bring up the Task View Search & Select form.  

• Parent Task ID 

Enter the parent of the task you want to set as the link target. Use the Visual 
Assist to bring up the Task Search & Select form.  

The Find Relationship form lists all of the child tasks of the parent you searched on.  

7. Choose the task you want to set as the link target, and then click Select.  

The link target is the task that appears in the second window when the user invokes 
the link. The system uses the information you provided to complete the required 
fields in the Link To form.  

8. Click OK.  

9. On Task Relationship Revisions, click OK.  

The link task appears in the task view with a red arrow to indicate that it links to 
another task.  

Creating a Link to a Variant Task View Menu  

Creating a link to a variant is useful when you link task views as part of completing a 
business process. You might decide that users who link from one task view to another might 
need variants of a task relationship.  

Before You Begin  
� Apply the variant to the task link child.  

► To create a link to a variant task view menu  

1. In a task view of Solution Explorer, select the parent of the task that you want to 
make the link task  

2. Right-click the task you selected, and then choose Task Relationships.  

The Task Relationship Revisions form appears, listing the child tasks of the parent 
you selected.  

3. From the list of tasks, click the task you want to set as the link task.  

4. From the Row menu, choose Link To.  

5. On the Link To form, click the Find Relationship button.  

6. On the Find Relationship form, complete the following fields, and then click Find:  

• Task View 

Use the Search button to bring up the Task View Search & Select form.  

• Parent Task ID 
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Enter the parent of the task you want to set as the link target. Use the Search 
button to bring up the Task Search & Select form.  

The Find Relationship form lists all of the child tasks of the parent you searched on.  

7. Choose the task you want to set as the link target, and then click Select.  

This is the base of the variant task view that appears in the second window when the 
user invokes the link. The system uses the information you provided to complete the 
required fields in the Link To form.  

8. In the Link to Variant field, enter the Variant ID.  

This is the variant task view that users see in the second window when they activate 
the link. Use the Visual Assist in the Link to Variant control to locate the variant to 
which you want to link.  

9. Click OK.  

10. On Task Relationship Revisions, click OK.  

The link task appears in the task view with a red arrow to indicate that it links to 
another task.  

Deleting a Link  

To delete links, you revise the task relationships.  

► To delete a link  

1. In a task view of Solution Explorer, select the task link parent with the link you want to 
remove.  

2. Right-click the task you selected, and then choose Task Relationships from the 
menu.  

3. On Task Relationship Revisions, choose the task with the link you want to delete, 
and then choose Remove Link To from the Row menu. 

4. Click OK.  

The system removes the link.  

Documenting Tasks  

Task documentation allows new system users to acquaint themselves with the purpose of a 
task, the steps required to complete it, and points to be aware of before beginning a task. 
Task documentation enables other users to create notes that clarify a business process and 
to provide links to other documents that result from completing a task, such as an invoice.  

Many J. D. Edwards tasks already have documentation when you install the Solution 
Explorer. However, you can edit documentation using the Solution Explorer toolbar and an 
HTML editing tool, such as Microsoft Word. In addition, you can use your editing tool to write 
your own documentation.  
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Warning 
Any modifications you make to J. D. Edwards-provided documentation will be lost when you 
update your system. Documentation you create yourself, however, will remain intact.  

 
The Solution Explorer task view includes a documentation window, which displays task 
documentation in HTML format. When you categorize a piece of documentation for the 
Solution Explorer, you define it as being one of several instruction types, including Summary, 
Detail, Before You Begin, Notes, Deliverables, or Custom. These instruction types 
correspond to the names of the tabs that appear in the documentation window. For example, 
you might create two documents, defining one to be Summary and the other to be Detail. 
Consequently, users viewing documentation for that task would see two tabs in their 
documentation window: Summary and Detail. The documentation window is available both in 
the Solution Explorer and within the Universal Director.  

Understanding Task Documentation Order of Precedence  

To determine what to display in the task documentation window, the Solution Explorer 
performs the following steps. For each task, the system performs these steps for every 
documentation category in the system.  

5. The system checks to see if documentation has been associated with the current 
task. If such documentation exists, the system displays that documentation. If not, the 
system proceeds with the second check.  

6. If no documentation is available on the task level, the system checks to see if 
documentation has been associated with the task view. Task view documentation is 
actually associated with the task view node (the first task at the top of the task view). 
If such documentation exists, the system displays that documentation. If not, the 
system proceeds with the third check.  

7. If no documentation is available on either the task or the task view levels, the system 
checks for global documentation that resides in the root of the documentation 
directory. If the file exists, then the system displays the file's contents in the 
documentation window. If the file does not exist, the system does not display a tab for 
that category.  

8. You can create and edit global documentation, but you must do so outside of the 
Solution Explorer. Note that each category uses a different file for global text. For 
example, if you wanted global documentation for both the Detail and Consequence 
categories, you would create two files: detail.htm and consequence.htm.  

The documentation associated with parent tasks is not checked as part of this order of 
precedence. For example, in a task view, you might have a parent task containing a child 
task. Even if the parent task has documentation associated with it, if the child task does not 
have documentation, the system displays the documentation associated with the task view 
and not the documentation associated with its parent.  

Creating Documentation  

You can write documentation of different types for any task in the Solution Explorer task view. 
Documentation might provide general information about a task, specific steps that you follow 
to complete a task, discussion of steps to take before you begin a task, or information that 
you customize for a particular task.  

The documentation appears in the Solution Explorer documentation window each time you 
select a task in a task view, provided you have chosen Show from the View menu and clicked 
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Task Documentation. Tabs in the documentation window represent documentation instruction 
types that exist for a task. If you have not written documentation for the task, you can display 
a web site or HTML message for each task that does not have documentation.  

To create the documentation, you click the arrow on the Edit button in the documentation 
window toolbar and choose the type of documentation you want to provide.  

Before You Begin  
� In the Solution Explorer, from the View menu, select Show and then select Task 

Documentation. This option displays the task documentation window.  

► To create documentation for tasks  

1. In a task view of Solution Explorer, select a task or task view.  

The documentation appears in the documentation window.  

2. In the documentation window, click the arrow on the Edit button in the documentation 
pane.  

3. Choose an instruction type from the drop-down menu.  

The Solution Explorer Documentation form appears.  

The Solution Explorer Documentation form contains the file name, which refers to the 
instruction type you chose and the full path to the documentation file you are writing.  

4. Click Yes to continue.  

The system launches the editing tool that you use in your system, such as Microsoft 
Word.  

5. Using the editing tool, write the documentation.  

6. Save and close the document when you are finished.  

The system creates a tab that represents the documentation instruction type that you 
created. You might need to click Refresh to see the new documentation.  

Revising Documentation  

The system also allows you to revise documentation that you have already written. To revise 
documentation, click the Edit button in the documentation window, open the document, make 
changes, and save it.  

Before You Begin  
� In the Solution Explorer, from the View menu, select Show and then select Task 

Documentation. This option displays the task documentation window.  

► To revise documentation  

1. In a task view of Solution Explorer, select a task containing documentation you want 
to revise.  

The documentation appears in the documentation window.  

2. Click the tab that represents a type of previously created documentation, such as 
Summary.  
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3. Click Edit.  

The system launches the editing tool that you used to create the documentation, and 
retrieves the HTML file you created.  

4. Edit the existing document.  

If your HTML editor is Microsoft Word, the document might appear blank initially. In 
the Microsoft Word toolbar, click View, then choose HTML Source. You can now edit 
the HTML document.  

Note 
If the documentation's Special Handling parameter is blank, you cannot edit the file. 
When you click the pencil button, the Solution Explorer Documentation form informs 
you that the file cannot be edited. See Adding an Instruction Type for more 
information.  

 
5. Save and close the document when you are finished.  

You might need to click Refresh to see the new documentation.  

Adding a Documentation Category  

Instruction types refer to the category of documentation for tasks in your system. For 
example, Summary is an instruction type that provides a high-level overview and definition of 
the task. The system allows you to create an instruction type for your system by adding a 
type to the UDC table that stores instruction types and information about them. Each 
documentation type is identified by its own tab in the documentation window.  

When you add an instruction type, you can specify whether you want to allow the 
documentation files to be edited. If you want to control access to documentation, make sure 
that you apply a special handling parameter that prevents users from editing the documents.  

► To add a documentation category  

1. In System Administration Tools (GH9011), launch User Defined Codes (P0004A).  

2. On Work With User Defined Codes, enter H90 in the Product Code field.  

3. In the User Defined Codes field, enter IN for Instruction Types.  

4. Click Find, and then click Add.  

5. In the User Defined Codes form, enter data in the following fields and click OK:  

• Codes: The order in which the tabs in the documentation window will appear  

• Description 1: The instruction type, which is the tab title that will appear in the 
documentation window  

• Description 2: The file name, which is the name of the instruction type with an 
HTML extension  

• Special Handling: The display properties of the documentation. An E means that 
the file will be displayed and is editable. If you leave the column blank, the file 
displays, but it cannot be edited. An N means that the file will not be displayed.  

6. Close the Work With User Defined Codes form.  
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Activators  

To make the process of working through a series of tasks easier and less time consuming for 
end users, Solution Explorer provides a way to group tasks together. This group of tasks is 
called an activator. The system displays these tasks to the user with a tool called the 
Universal Director. With the Universal Director, users can work through tasks sequentially by 
clicking the Next button after they complete each task.  

For example, you can create an activator containing the steps necessary to close out a 
quarter.  

Understanding Activators  

An activator is a sequential series of tasks that are required to perform a process that is 
integral to the functioning of your business.  

The task that can launch an activator is always a parent task and is designated by an 
activator flag. Typically, the launching task is a non-software task under which the rest of the 
activator tasks reside. After you have created the activator, users executing the activator 
launch the Universal Director, a feature that provides a self-contained area in which you work 
with all the tasks in the relationship. While you are using the Universal Director to run 
activator tasks and task relationships, the system uses data mapping to pass data between 
tasks in the task relationship. The Universal Director guides you through each step of the 
process until you reach completion.  

If you want to make changes to the activator, you make them in the Solution Explorer task 
view. Any changes that you make to the task relationship are automatically reflected when 
the Universal Director runs.  

Activator Flags  

An activator flag designates a task as a parent task under which the rest of the activator tasks 
reside. To enable an activator flag, you enter an activator type in the Task Revisions form. 
With the activator flag turned on, the task name displays a lightbulb symbol in the task view.  

31 



 

 

Double-clicking an activator or clicking the Idea to Action button in the Solution Explorer 
toolbar launches the Universal Director. The Universal Director presents each of the tasks in 
the process in sequential fashion. Within the Universal Director, users work with any 
interactive and batch applications necessary to complete the business process keyed by the 
activator.  
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Any sequence of tasks constitutes a task relationship in a broad sense. The tasks that you tie 
together might be tightly related. However, when you designate a parent task as an activator 
and launch the Universal Director, the system formally presents the tasks together in one 
unifying view. In addition, the system passes data between forms without hard-coded form 
interconnections. To alter a business process keyed by an activator, you change the task 
relationship in the Solution Explorer task view.  

In addition, you can designate the type of activators you want to set up. Activator types 
include business and technical activators. Although the activator type does not affect how the 
activator works, by defining an activator as one type or another, you can more easily search 
for an activator.  

You use business activators to implement rapid change to your system without having to 
consume development resources. You designate a task as a business activator if it is a part 
of the essential processes of your system. For example, a task such as New Company 
Acquisition would be a business activator. It triggers a process that ties together a sequence 
of related tasks, each of which you complete in a specified order to accomplish the goal. 
Other business activators might include adding a warehouse or creating customized reports 
and invoices.  

You designate a task as a technical activator if it is part of the management and maintenance 
of your system infrastructure. Technical activators offer simplified system management in 
such areas as permissions, server administration, and component interfaces. For example, 
these activators allow information technologists to implement and maintain a package 
installation process. Technical activators, which automate processes such as these, free 
technical professionals to work on ensuring that the system performs to its maximum 
capability.  
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Universal Director  

Activators enable you to create task relationships and pass data between forms without 
writing code that is embedded in Event Rules or in Workflow. The Universal Director creates 
a compact area in which users view and work with the tasks in your work process. The 
Universal Director presents the activator and all the tasks related to it in the sequence that 
you created in Solution Explorer.  

The Universal Director allows you to move forward and backward within the task sequence, 
and it clearly displays your position within that sequence. You accomplish this movement 
within the view by using the director bar.  

The Documentation view is also visible to you when you are working with the Universal 
Director. The system displays the documentation that corresponds to the particular task you 
are working on in the Universal Director view. You can manipulate and edit the 
documentation while you work in the Universal Director, just as you can from Solution 
Explorer.  

In short, the Universal Director presents another view of the activator parent-child task 
relationships that exist in the Solution Explorer task view. However, it also provides the 
interface for you to execute the tasks in those relationships.  

Data Mapping  

The Universal Director provides data mapping, which passes data between forms as you 
work on the tasks in the sequence. This data mapping mechanism ensures that you can pass 
data between forms logically without hard-coding form interconnections.  

During data mapping, the Universal Director validates that a value-containing header control 
or grid column in one form has a header control or grid column match in the next form. If the 
match exists, the Universal Director passes the value. If no match exists, data mapping fails 
and the Universal Director generates an error message. You activate data mapping by 
entering Y in the Auto Data Passing grid column in the Task Relationships Revision form for 
each task that is to pass data to another task within the task relationship.  

Creating an Activator  

To create an activator, you first need to create and designate a parent task as the launch 
task, and then you turn on the activator flag for that task. A launch task serves as the parent 
task of a relationship that constitutes a key business or technical activator. Typically, launch 
tasks are non-software tasks. You create them in the same way you create any other kind of 
task. A task that you have designated as an activator appears in the task view with a lightbulb 
symbol.  

Once you have created the launch task, you can place as many child tasks under it as you 
require to complete the process. Then, when you select the launch task and click the Idea to 
Action button, the system launches the Universal Director. From the Universal Director, you 
can step through the entire sequence from beginning to end, working in any applications that 
are necessary to reach completion.  
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► To create an activator  

1. In a Solution Explorer task view, create or select a non-software task.  

If you select a task, right-click the task, and then select Task Revisions.  

2. On the Task Revisions form, complete the fields and options on the Common, 
Executable, and Resources tabs as required, making sure to enter either a 1 or a 2 in 
the Activator Type field, and then click OK.  

The system places a lightbulb symbol on the task icon to designate the task as being 
a launch point for an activator.  

3. To finish creating the activator, insert as many tasks required to complete the 
transaction in the proper order.  

You can place tasks in the activator by creating them or by sending them to the task 
view from another task view and then dragging and dropping them in their proper 
locations.  

See Also  
� Creating a Task  

Example: Creating an Activator  
This example creates an activator for adding new users to the system. After completing the 
process, you can launch its activator and the Universal Director will automate the process of 
completing the steps.  

► To create an activator  

1. Determine the steps required to complete the process.  

Generally, you will need to decide what applications a user will need to run and in 
what order they have to be run.  

In the add user example, the following list identifies the steps to be completed and 
the application used to complete each step. Later, each step will be the basis for its 
own task in the process. Notice that the task name is not the same as the application 
name. Although you could use the application name as the task name, describing the 
action to be performed rather than listing the application to use makes the process 
clearer to the user. In this example, all of the applications are J.D. Edwards software 
applications.  

Observe that some applications have more than one step applied to them.  

Add user profile  User Profile Revisions (P0092)  

Add user profile environments  User Profile Revisions (P0092)  

Add user profile security  OneWorld Security (P980WSEC)  

Add user row security  Security Workbench (P00950)  

Add user action security  Security Workbench (P00950)  

Add user machine  Deployment Locations Application (P9654A)  
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2. Create the parent task.  

This task will serve as the launch task later in the example. The parent task should 
be a placeholder--a non-software task. When you create the task, complete the Task 
Revisions form as follows. If a field is not mentioned, then leave it blank.  

• Task ID: H95_ADD NEW USER  

• Task Name: Add New User  

• Common tab fields  

• Product Code: H95  

• Activator Type: 1  

• Active: (selected)  

• Executable tab fields: select the Non-Software option  

Putting a value in the Activator Type field is critical; if you do not, the system will not 
mark the task as a launch task and the user will not be able to access the Universal 
Director to automate the child tasks.  

3. Add a task called Add User Profile as the first child of the Add New User task. When 
you create the task, complete the Task Revisions form as follows. If a field is not 
mentioned, then leave it blank.  

• Task ID: H95_ADD USER PROFILE  

• Task Name: Add User Profile  

• Common tab fields  

• Product Code: H95  

• Active: (selected)  

• Executable tab fields: select the Interactive option  

• Application: P0092  

• Version: ZJDE0001  

• Form: W0092A  

• Option Code : 1  

4. Add the remaining tasks, in order, as children of Add New User following the Add 
User Profile task.  

In this example, you are creating all of the tasks for the process. However, you can 
insert already existing tasks into the process as well. You can also send tasks to the 
task view and then drag and drop them in the correct place.  

Set up each task similarly to how you were instructed to name the last two tasks. Use 
the following parameters on the Executable tab of the Task Revisions form:  

• Add User Profile Environments  

• Application: P0092  

• Version: ZJDE0001  

• Form: W0092C  

• Option Code : 1  
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• Add User Profile Security  

• Application: P98OWSEC  

• Version: ZJDE0001  

• Form: W98OWSEC  

• Option Code: 1  

• Add User Row Security  

• Application: P00950  

• Version: ZJDE0001  

• Form: W00950F  

• Option Code: 1  

• Add User Action Security  

• Application: P00950  

• Version: ZJDE0001  

• Form: W00950M  

• Option Code: 1  

• Add User Machine  

• Application: P9654A  

• Form: W9654AB  

5. To test the process, click the Add New User activator, and then click the Idea to 
Action button on the Toolbar.  

The steps in the tree on the left of the Universal Director mirror the tasks you added 
to create the process.  
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